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Crearea resurselor si alocarea costurilor
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Termenul de management din managementul de proiect sugereaza faptul ca supervizati
si aparent controlati ceea ce se petrece pe parcursul ciclului de viati al proiectului. In
laboratorul anterior ati aflat cum sa construiti sarcini ce compun proiectul. Acum va trebui sa
identificati resursele pentru fiecare sarcind. Unele sarcini necesitd doar oameni; alte sarcini pot
sd necesite si echipamente.

Odata cu crearea resurselor, veti observa ca diferite rate sunt asociate unei resurse. Cand veti
aloca o resursa pentru o sarcind din proiectul vostru, Microsoft Project va incepe automat
calcularea costului proiectului.

1. intelegerea resurselor

Resursele reprezintd oamenii, materialele si echipamentele ce va permit finalizarea
sarcinilor din proiectul vostru. In versiunile anterioare Project 2000 puteati defini doar resurse
de munca — oameni sau echipamente ce consumd timp atunci cand lucreaza la o anumita
sarcind. Atunci cand definiti resurse de munca, definiti timpul pe care resursele respective il
consumi intr-un proiect (100% reprezinti timpul total). in mod similar, atunci cand alocati o
resursd de munca unei sarcini, indicati timpul pe care vreti sa il utilizeze resursa de munca
pentru sarcina respectiva (100% reprezinta timpul total).



Project 2000 a adaugat resurse materiale — elemente ce sunt consumate atunci cand
sunt alocate unui proiect. Resursele materiale folosesc evident materiale precum combustibil
sau lemn — 1n loc de timp. Atunci cand alocati o resursd materiald unei sarcini, specificati
cantitatea din resursa materiala pe care intentionati sa o folositi, data in unitéti ce sunt potrivite
pentru resursa materiala respectiva. Puteti deasemenea sa indicati dacd acea cantitate de
material folosita este dependentd de timp. Spre exemplu, numarul de litri de apd folositi la
udarea unei peluze depinde de timpul cat apa curge si de debitul rebinetului pe unitatea de
timp. Sau puteti sd indicati faptul cd existd o cantitate fixd de material. De exemplu, aveti
nevoie de cinci bucdti de placaj 2x4 pentru a construi o bancd — indiferent de cét timp v-ar lua
sa construiti acea banca.

Project 2002 va da posibilitatea sa definiti resurse generice — resurse (definite de voi)
ce nu reprezintd persoane, echipamente sau materiale specifice, ci mai degraba descrieri ale
aptitudinilor necesare pentru indeplinirea unei sarcini atunci cdnd nu cunoasteti ce resurse
specifice pot fi utilizate. Cu toate c@ aceasta resursa generica a fost construitd pentru a lucra cu
wizard-ul pentru substituirea resurselor (Resource Substitution Wizard) si cu resursele
companiei (Enterprise Resources — existente in Project Server), veti gasi resursele generice
utile chiar si daca nu folositi Project Server. De exemplu, puteti folosi resursele generice atunci
cand nu va intereseaza cine face un anumit lucru, ci doar doriti sa tineti o evidentd a ceea ce a
fost finalizat in cadrul unui proiect.

Daca folositi Project Server, puteti sa va folositi si de trei facilitati inrudite. Puteti defini
resurse ale companiei (Enterprise Resources) — resurse ce sunt utilizabile la nivel
global, al companiei pentru proiecte. Optiunea Team Builder va ajutd sa selectati
resursele necesare proiectului vostru din colectia de resurse la nivelul companiei iar
wizard-ul pentru substituirea resurselor poate inlocui resursele generice cu resurse
efective.

Resursele costd bani si astfel folosirea lor influenteaza costul proiectului. Pentu a face
managementul unui proiect intr-un mod eficient, este indicat sd definiti resurse si sd le alocati
unor sarcini din proiect. Astfel, este necesar sd cunoasteti cum utilizeaza Microsoft Project
aceste alocari de resurse pentru a modifica durata si lungimea proiectului.

Sfat: Daca va asteptati sa folositi aceleasi resurse pentru mai multe proiecte, puteti sa
definiti resursele Intr-un proiect special care sd nu contind nici o sarcind. Ulterior puteti
folosi facilitatea de alocare a resurselor la nivelul companiei si aceea de ,,proiect de
resurse” pentru a partaja resursele intre mai multe proiecte. Aceasta abordare va permite
sd definiti resursele o singura data si apoi sa le folositi in mod repetat in cadrul multor
proiecte diferite.



1.1. Cum functioneaza resursele

Prin definirea si alocarea resurselor ulterior, atingeti urmatoarele scopuri:

e Puteti sd tineti evidenta sarcinilor ce sunt in desfasurare in functie de o resursa alocatd
ei — deoarece Microsoft Project identifica resursele care sunt alocate fiecarei sarcini.

e Puteti sa identificati potentialele resurse lipsd ce v-ar forta sd nu puteti respecta
calendarul si termenele limitd, ducand la extinderea duratei proiectului.

e Puteti identifica reusursele rar sau putin utilizate. Daca realocati aceste resurse existd
posibilitatea sa scurtati durata proiectului.

Atunci cand sarcinile create sunt effort-driven — Microsoft Project defineste toate sarcinile
implicit ca fiind effort-driven — resursele pe care le alocati unei sarcini afecteaza durata
acesteia. De exemplu, dacd puneti doi oameni sd faca un anumit lucru, acesta este finalizat de
obicei intr-un timp mai scurt decat daca ati fi pus un singur om sa faca acel lucru. Intrebarea
care se pune este cum este afectat costul? Determina utilizarea resurselor aditionale o crestere a
costului proiectului? Poate cd da - poate ca nu. Veti descoperi faptul ca finalizarea proiectului
intr-un timp mai scurt (prin utilizarea mai multor resurse) vd economiseste banii deoarece
puteti accepta noi proiecte mai repede. Sau poate ca puteti castiga un bonus pentru terminarea
proiectului mai repede decat era asteptat, acesta fiind indeajuns de mare incat sa acopere costul
resurselor aditionale pe care le-ati folosit.

1.2. Cum foloseste Microsoft Project informatiile resurselor
pentru a modifica programul proiectului

Pentru sarcini effort-driven, Microsoft Project foloseste informatiile pe care le dati referitoare
la resurse pentru a calcula durata sarcinei si indirect durata proiectului. Cu toate acestea, daca
stabiliti o duratd fixa pentru o sarcina, Project ignora resursele alocate pentru aceasta atunci
cand calculeaza durata proiectului. in mod similar, daca nu alocati resurse, Project calculeaza
programul folosind doar durata sarcinii si informatii referitoare la dependenta de alte sarcini.

Alocarea unei resurse pentru o sarcind poate afecta durata proiectului deoarece lucrul la
respectiva sarcind nu poate s inceapa pand cand nu este liberd resursa. Microsoft Project
foloseste un calendar al resurselor pentru a defini zilele lucratoare si intervalele orare
corespunzatoare pentru o resursa, insa disponibilitatea resursei depinde si de celelalte sarcini
catre care a fost alocata resursa.



Daca volumul de munca asociat unei resurse depaseste timpul disponibil, Microsoft Project
aloca resursa cétre acea sarcind si indica faptul ca resursa este supraalocata. Aceasta tehnica va
permite sa vedeti problema si sa decideti asupra modului de reparare a ei.

1.3. Cum colecteaza Microsoft Project informatiile de cost

Atunci cand atribuiti costuri resurselor si alocati resursele unor sarcini, Microsoft Project poate
calcula costul unui proiect. Pe langa costurile datorate alocarii resurselor, Microsoft Project se
ocupa si de costurile fixe, ce vor fi prezentate in finalul acestui laborator.

Aveti optiunea de a atribui costuri resurselor atunci cand le definiti, ala cum veti vedea
in sectiunea ,,Crearea unei Liste de Resurse” din acest laborator.

Atribuirea de costuri va permite sd monitorizati $i sa controlati banii pe care 1i veti cheltui pe
un proiect. Microsoft Project va aratd unde si cum va cheltuiti banii. Aceasta informatie va
permite sd controlati bilantul proiectului care in schimb va permite sa va planificati plata
facturilor aferente. Informatiile referitoare la cost pe care Microsoft Project vi le oferd va ajuta
sa verificati urmatoarele lucruri:

e Costul resurselor si materialelor pentru orice sarcina
e Costul oricarei faze ale proiectului precum si costul intregului proiect

Sfat: Informatiile referitoare la cost pe care le adunati pentru un proiect va pot ajuta sa
calculati evaluarea initiald a costurilor pentru proiecte viitoare.

2. Crearea unei liste de resurse

Nota: Daca intentionati sd incdrcati proiectul in Project Server s-ar putea sa doriti sa
alocati resursele din colectia de resurse ale companiei, un grup de resurse la nivelul
companiei.

Microsoft Project va oferd optiunea de a crea resursele una cate una, pe masurd ce va ganditi la
ele, sau prin introducerea tuturor (sau aproape tuturor) resurselor folosing tabelul de entitati
(Entity Table) din foaia de resurse (Resource Sheet). Pentru a vizualiza foaia de resurse trebuie
sa dati click pe butonul Resource Sheet din bara de comenzi de vizualizare sau sa alegeti View
-> Resource Sheet. Implicit, Microsoft Project afigeaza tabelul de entitati al foii de resurse.



Nota: Puteti s comutati tabelele folosind comanda View -> Table, dupa care sa
selectati din submeniul care apare. Fiecare tabel contine coloane cu un nume intuitiv.
Spre exemplu, tabelul Cost afiseaza coloane ce au legatura cu costul unei resurse.

Sfat: Pentru a adduga resurse unui proiect ce deja exista in altd locatie (cum ar fi
colectia de adrese ale companiei voastre sau care se afla in Microsoft Project Server),
dati click pe primul link de pe pagina de resurse a ghidului de proiect.

Daca folositi foaia de resurse pentru a defini majoritatea resurselor pentru proiectul vostru,
procesul de alocare a resurselor se va desfasura mult mai rapid deoarece nu mai trebuie sa va
opriti pentru a crea mai intai resursa. Totodata, folosirea foii de resurse este 0 metoda sigura de
a defini resurse; modul de prezentare vizual va ajutd s evitati crearea aceleiasi resurse de doua
ori. De exemplu, daca definiti Vickey si Vicki, Microsoft Project vede doua resurse cu toate ca
se poate sa fi facut o simpla eroare de tehnoredactare a numelui resursei a doua oara.

Puteti sd introduceti elementele de bazd pentru o resursa completind aceste elemente in foaia
de resurse; pur si simplu apasati Tab pentru a va muta de la un camp la altul (din celuld in
celuld). Foaia de resurse prezentatd in figurd nu aratd toate campurile descrise in acest
laborator. Derulati foaia spre stanga pentru a vedea si restul tabelului de entitati a foii de
resurse.

Sfat: Puteti sa personalizati foaia de resurse pentru a arata multe campuri aditionale pe
care ati putea sa le stabiliti pentru fiecare resursd in parte. De exemplu, daca aveti
nevoie sa introduceti manual adresa de e-mail pentru fiecare resursa, puteti sd adaugati
coloana E-mail Address in foaia de resurse.

Nota: Ca parte a ghidului Microsoft Project, puteti sa 1i cereti programului sa va ajute
in procesul de creare a resurselor. Pagina de resurse a ghidului Microsoft Project,
vizibild in figura precedentd, apare atunci cand afisati foaia de resurse sau atunci cand
apasati click pe butonul de resurse din bara de unelte a ghidului Microsoft Project.
Apasati pe una din link-uri pentru a naviga prin pasii asociati.

Un cdmp este o celuld intr-un tabel in care introduceti informatia corespunzétoare. Toate
tabelele si vizualizari ale acestora contin campuri. Fiecare camp al foii de resurse serveste un
scop specific dupa cum urmeaza:

e Indicators (Indicatori): Desi nu puteti sa scrieti direct in cAmpul de indicatori, icoane
apar aici din cand in cand. Unele icoane apar ca raspuns al Microsoft Project la o
actiune pe care ati facut-o. De exemplu puteti observa un indicator pentru o resursa
supraalocati. In alte cazuri un indicator apare pentru ci ati introdus o noti referitoare la
o resursa. Consultati sectiunea ,,Adaugarea de note pentru o resursa” din acest laborator
pentru mai multe informatii.



Sfat: Daca mentineti mouse-ul deasupra unui indicator, Microsoft Project afiseaza
informatia asociata icoanei.

Resource Name (Numele resursei): Introduceti numele resursei. Pentru o persoana,
puteti s@ introduceti numele persoanei sau puteti s scrieti o descriere a postului, cum ar
fi Product Analyst I sau Product Analyst 2.

Type (Tipul): Folositi aceasta coloana pentru a specifica daca definiti o resursa umana
sau materiald. Microsoft Project se refera la resurse umane ca Activitate (Work).
Material Label (Eticheta de material): Pentru resursele materiale, specificati unitatea
de masura. Puteti sd specificati orice eticheta doriti. De exemplu, puteti sa scrieti
minute pentru distante lungi, metri liniari pentru lemn sau kilometri pentru combustibil.
Initials (Initiale): Scrieti initialele pentru o resursd sau acceptati-o pe cea implicitad pe
care Microsoft Project o specifica, care este formatd din prima literd a numelui resursei.
Aceasta specificare apare in toate vizualizarile cirora le adaugati cAmpul cu initiale. in
mod normal apare numele resursei, insd va puteti personaliza vizualizarea pentru a afisa
initialele daca preferati acest lucru.

Group (Grup): Alocati resurse grupurilor daca acestea au aceleasi caracteristici
comune, cum ar fi functia pentru un post. Ulterior puteti sd folositi acest cAmp intr-un
mecanism de filtrare sau sortare §i sa afisati informatii despre un grup (o functie
particulard pentru un post) in loc de informatiile pentru o resursa specifica. Trebuie
doar sa introduceti un nume pentru a crea un grup.

Sfat: Asigurati-va ca ati introdus numele grupului de fiecare data in acelasi fel daca
doriti sa filtrati sau sortati dupa grupuri.

Max. Units (Maximul de unitati): Microsoft Project exprima cantitatea de resursa de
munca pe care o aveti disponibild pentru alocare in procente. De exemplu, 100% este
egal cu o unitate sau cu echivalentul lucrului non-stop al acelei resurse; 50% este egal
cu jumatate dintr-o unitate sau o jumatate din timpul de lucru non-stop al acelei resurse;
iar 200% este egal cu doua resurse ce lucreaza non-stop.

Std. Rate (Rata standard): Rata standard este rata pe care o modificati pentru lucru in
mod curent pentru o anumita resursa. Microsoft Project calculeaza rata implicita in ore.
Cu toate acestea, puteti schimba modul de descriere a lucrului unei resurse in unitéti
diferite de timp. (Pentru resurse de lucru, puteti folosi minute, zile, sdptdmani sau ani.
Pentru resurse materiale ganditi-va la costul folosirii acestora per unitate, bazat pe
eticheta materialului). Pentru a specifica un increment de timp diferit de ore, introduceti
un / urmat de prima literp a cuvantului ce reprezintd incrementul de timp. De exemplu,
pentru a schimba utilizarea resursei in zile, scrieti /d dupa rata pe care o specificati.

Ovt. Rate (Rata de lucrur suplimentar): Rata de lucru suplimentar (Overtime Rate)
pe care o cheltuiti pentru munca suplimentara pentru o resursd. Din nou, Microsoft



Project calculeaza rata implicitd in ore, nsd puteti sa schimbati unitatea implicitd in
acelasi mod in care ati schimbat-o pentru rata standard.
Cost/use (Cost/Utilizare): In coloana Cost/Use (se citeste cost per utilizare) introduceti
o rata a costurilor ce sunt percepute pentru fiecare utilizare a resursei. Costurile resursei
pot sd se bazeze pe rata standard (care este calculata prin inmultirea numarului de ore
cu costul pe ord), pe rata de cost/utilizare (o suma fixa pentru utilizarea resursei) sau o
combinatie a celor doud. Microsoft Project foloseste o combinatie a celor doud cand
calculeaza costul unei sarcini. Daca inchiriati un echipament ce costa 25$ /ora plus un
cost de instalare de 1008, pueti specifica o ratd standard de 25% si o ratd de
cost/utilizare de 100$.
Accrue At (Calculeaza la): Acest camp specifica cum si cand sa perceapa Microsoft
Project costurile pentru resurse pentru o sarcind la rate standard sau de lucru
suplimentar. Optiunea implicitd este Prorated, insa puteti selecta si Start (la Inceput) sau
End (la sfarsit). Cele trei sunt descrise dupa cum urmeaza:
o Daca selectati Start si alocati acea resursa unei sarcini, Microsoft Project va
calcula costul sarcinii imediat ce sarcina incepe.
o Daca selectati End si alocati acea resursa unei sarcini, Microsoft Project va
calcula costul sarcinii cand sarcina se va termina.
o Daca selectati Prorated si alocati acea resursd unei sarcini, Microsoft Project va
acumula costurile sarcinii 1n functie de finalzarea sarcinilor programate.

Sfat: Daca specificati rata de cost/utilizare pentru o resursd si o alocati unei sarcini,
Microsoft Project va folosi campul Calculeaza la pentru a determina daca costul va fi
aplicat la Tnceputul sau sfarsitul sarcinii. Daca setati campul Calculeaza la ca fiind la
inceput sau acumulat, Microsoft Project percepe costurile la inceputul sarcinii. Daca
specificati campul Calculeaza la ca fiind la sfarsit, Microsoft Project percepe costurile
la sfarsitul sarcinii.

Base Calendar (Calendar de bazd): Calendarul de baza identifica acel calendar pe care
Microsoft Project il va folosi atunci cand programeaza o resursa. Calendarul identifica
timpul de functionare si nefunctionare al resursei. Microsoft Project presupune ca
fiecare resursa foloseste calendarul standard, insa asa cum veti afla in acest laborator,
puteti crea calendare pentru grupuri de resurse (de exemplu pentru a stabili schimburi
de ture) sau puteti modifica un calendar al unei resurse individuale pentru a reflecta
concediul sau timpul indisponibil.

Code (Cod): Puteti folosi acest camp ca un camp descriptiv caruia ii puteti asocia orice
informatie doriti pentru resursa, folosind o abreviere de un anumit fel. De exemplu,
atunci cand corporatia voastra foloseste coduri pentru centre de plata. Ati putea dori
astfel sa specificati codul centrului de platd in campul de cod. Puteti sa sortati i sa
filtrati informatia dupa abrevierile pe care le specificati n campul de cod.



Nota: Dupa ce creati o resursa, Microsoft Project afiseaza ID-ul resursei pe marginea
din stanga a foii de resurse, la stdnga coloanei indicator.

3. Modificarea informatiilor unei resurse

Tocmai ati invatat o metoda rapida de definire a unei resurse, prin completarea directd a
Resource Sheet. Pe langa aceasta, mai puteti folosi fereastra de dialog Resource Information
pentru a rafina caracteristicile unei anumite resurse. Pentru a accesa acest meniu, faceti dublu
click pe orice resursd din Resource Sheet sau alegeti Project => Resource Information, apoi
selectati tab-ul General.

Majoritatea informatiilor de aici au fost deja completate editdnd direct Resource Sheet-ul,
astfel Incat aceastd sectiune va explicita campurile specifice ferestrei de dialog ce nu apar
implicit in tabela de pe Resource Sheet.

3.1. Setarea unei modalitati de comunicare

Folositi campul Email, prezentat in Figura 5-2, pentru a completa adresa de mail
caracteristica unei resurse. Acest camp trebuie completat dacd se doreste folosirea
facilitatii de workgroup a proiectului, ce permite utilizatorilor sd asigneze, accepte sau
sa refuse task-uri In mod electronic. Puteti face o selectie dintr-un control drop-down al
workgroup-ului pentru a seta modul de comunicare electronica.
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Figura 5-2. Folositi tab-ul General al ferestrei de dialog Resource Information pentru a
adauga informatii despre o resursa, ca de exemplu adresa de email sau disponibilitatea

3.2. Outlook si MS Project

Daca folositi Outlook si aveti stocate in agenda diverse adrese de contact, puteti accesa
butonul Details din fereastra de dialog Resource Information pentru ca Project sa caute
adresa de mail doritd in cadrul acestei agende. Puteti apoi selecta adresa cdutata si
completa campul Email cu aceasta ( copy-paste ).

Totusi, aceeasi adresd poate fi gdsitd mai repede folosind link-ul Specify people and
equipment for the project ( Specificd persoane si echipament pentru proiect ) de pe
pagina Resources a Project Guide. Cand accesati acest link, vi se oferd patru optiuni in
pagina nou deschisa. Alegeti a doua optiune - Add resources from the company
Address Book -, accesati link-ul Address Book care apare (vezi figura urmatoare) si
urmariti instructiunile oferite.



&) 3) Specify Resources X
Do you want to:
O .ﬁ.u:lu:l_ resources from

Project Server

® add resources from the
company Address Book

¢ Add resources from the
cornpany directory

{7y Enter resources rmanually

Click the link below to bring up
the company Address Bool:

Address Boolk..,

In the Select Resources
dialog that is brought up,
choose the resources you
want, and click the Add button
to add these resources to the
project.

Q Hint

Set booking types

You may also set the booking
types for resources in this
project.

Done

it Chiar daca Project 2003 ofera suport pentru workgroup-uri de email-
— uri, Microsoft a hotdrat sa renunte la acestd facilitate in versiunile

ulterioare.

3.3. Specificarea disponibilitatii unei resurse

Sa presupunem cd definiti o resursa care sd reprezinte o anumitad ocupatie, precum
resursa Intern prezentata in Figura 5-2. Sa presupunem apoi ca aveti mai multe astfel de
resurse, dar nu toate disponibile mereu. Folosind sectiunea Resource Availability, puteti
specifica o perioada de timp pentru care resursa respectiva este disponibila. Figura 5-2
indicd faptul ca 3 interni sunt disponibili intre 1 iunie si 31 iulie, si doar un singur
intern este disponibil pe durata lunii august.
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3.4. Specificarea unui tip de rezervare

Incepand cu Project 2003, puteti specifica un mod de rezervare pentru o anumiti
resursd. Rezervarea este folositd in general in mediul unei intreprinderi, unde folositi
facilitatea Enterprise Resource Pool. Sunt disponibile doud modalititi de rezervare:
committed si proposed (vezi Figura 5-3). O resursa rezervatd in mod committed este o
resursa atasatd in mod official proiectului. Propunerea de folosirea a unei resurse indica
faptul ca acea resursa nu este inca asignatd proiectului in mod oficial, ceea ce nu
determina modificari in calendarul aceului resurse. Un alt project manager ar putea sd
rezerve in mod commited resursa la un alt proiect pentru acelasi time frame, iar MS
Project NU va detecta supra — alocarea acelei resurse. Project nu ia in considerare

rezervarile propuse atunci cand calculeaza alocarea resurselor.

Tip
»,  Modul de rezervare selectat pentru o resursa se aplica pentru toate task-
urile din proiect care lucreaza cu respectiva resursa.
(Resource Information =]
General ] warking Time Costs Totes | customFeids |
Resource name: | Intern Initials: II
Emai; ] Groyp: I
Workgroup: J Default =| Code: [
windows Account... | | Type: | wark -
Booking type: Committed = = [
Proposed (] ;
Committed r el
Resource fovailabilty
073172003 A
| Avallable From Avalable To
06/01 /2003
W
Help Detalls... | & | cancal |

Figura 5-3. Alegerea modului de rezervare a resursei.
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3.5. Crearea unei resurse generice si atribuirea de campuri
personalizate

Resursa Intern ce a fost exemplificatd in sectiunile anterioare este, in esentd, o resursa
generica. Este o descriere a unei ocupatii, nu o persoana. Pentru a marca o resursa ca
fiind generica, bifati check box-ul corespunzator de pe tab-ul General al ferestrei de
dialog Resource Information (vezi Figura 5-3). Compania dumneavoastra ar putea seta
campuri custom in Project care sa se aplice resursei generice definite. Pentru a asigna
campurile custom dorite, accesati tab-ul Custom Fields setati valorile necesare pentru
resursa voastra genericd, asa cum este prezentat in Figura 5-4.

Atunci cand selectati OK pentru a inchide fereastra de dialog, veti vedea o icoana in
coloana Indicator precum cea prezentata in Figura 5-5. Aceastd icoand specifica faptul
ca resursa este generica.

Resource Information (%]
General |  workngTime | Casts | Motes Cuestom Fislds
Resource name; Ilﬂb\?ﬂ"
Custom Fiskds:
%1 1| Programming i’
Custom Fieid Name | Value =
Education (Textl) | Col=ge
Computer skils neaded (Text2) Programeringl .
Word processing
Spreadsheet
Proage Smimirsg
|
Help | oK | cancel |

Figura 5-4. Puteti asigna cdmpuri custom resurselor generice
pentru a descrie atributele acestora
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(47 File Edit Wiew Insert Format Tools Project Collaborate Window Help Type & question for fielp - @ X
EN = i = - A eSS JI“?I%!— sagal b |8 | G |, Mo Group = ool o | Gk
HIPC T " Show= | A -8 ~|B 7 U |[=]|= = |-~llRrescurces = o | s
) Fesource MName Type sterial Label  Initials | Group | mizx. Unts | Std.Fste | Ond. Rate Costilse |Ag a
1 Joe Johnson Wyiork o 100% F2500%&r B0.00hr 000 Pr
2 Deena Tanenblstt | Work o 100%  $25008r $0.00vhr $0.00|Pr
3 Blen Peck Work E 100%  $2000#r $0.00uMr $0.00 | Pr
=) Baob WWoock wvork B 100% FE0 008 B0 O0hr F0.00 Pr
5 Do Lahr Work [ 100%  $25008r $0.00vMr F0.00 | Pr
= Intern wiork | 300% $15004r $0.00Mr F0.00 Pr
7 Long distance Work L 100% F3004r $0.00Mhr $0.00 | Pr
8 Lumber Materisi f L $0.00 F1.25 | Pr
=l Gazoline Materisd sl = £0.00 $1.85 | Pr

Ready I [E2T Tcees o [Sear |

Figura 5-5. Puteti identifica resursele generice dupa icoana prezentata in
coloana Indicator

3.6. Adaugarea de note (comentarii) unei resurse

Acesati tab-ul Notes al ferestrei Resource Information. Casuta Notes prezentatd in
Figura 5-6 permite stocarea de informatii de orice fel legate de o resursa. De exemplu,
ati putea stoca un reminder legat de urmatoarea perioadd de disponibilitate a resursei
sau o explicatie legatd de acest subiect.
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Resource Information %]
General | werking Time | Costs Notes ] Custom Fields |

Resource [jame: | Intern

MNotes:
NEEEER

O July 31, two inberns leave to refumn fo school

Help petaks... | [ o ]|  cancel

Figura 5-6. Tab-ul Notes

Dupa ce ati completat acest camp si ati acceptat modificarile facute, o icoand Note va

aparea in coloana Indicator aferenta din Resource Sheet (vezi Figura 5-7).

!Nme Project afiseazd informatii despre toti indicatorii aplicabili unei resurse
— atunci cand este selectat campul aferent din coloana Indicator
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40 Hile Edit View Insert Format Tools Project Collaborate Window Help l'ype squsstion for Felp. = @ X
AR TG A ) B e | ] )| Mosow | Ll e g
ia o Show- | Arig 6 =B F IO |§ = | Al Resuuces * | N -
O ResoweName  [Tre  Meferlellabel ntisls  [Group [ MaxUnis  Sto.fiste | Ot.Rele | Costlse Aca
1 Jo Jobngon Wiiork o 100% §25 008 B0, Dihr F0.00 Pr_ |
2 Cwena Tanenklatt Wiork o 100% J25 004 BO.00hr F0.00 Pr
3 EilznPeck o E 100% JA0 00k i Finoon | P
4 Ewab ¥Woock ‘Whiork B 100% 33000 £0.00vhr F0.00 | Pr
5 Lo Lahr Wark C A00% 25004 BO.00hr $0.00 | Pr
8 [ Inteien iy ; i 0% $IS006r F0.008¢ $0.00 Pr
7 \;} Hiokes "On July 31, o interns leave | L 005 F3 00 S00.00hr 000 'pr
- ba reburm ko school” | - e =
- i Genenc Resource | ? : i
3 . & H0.00 185 Pr

Ready [F o
Figura 5-7. Nu trebuie sa deschideti fereastra Resource Information pentru a citi o nota.
Este suficient sa va pozitionati cu pointerul mouse-ului peste icoana din coloana
Indicator si Project va afisa continutul acelei note.

4. Calendare si resurse

Project foloseste un calendar de baza — Standard calendar — pentru a calcula schema de
timp a proiectului. La creearea unei resurse in cadrul proiectului, Project foloseste acest
calendar standard in mod implicit, consideran un program lucru de 8 ore / zi, 40 ore/
saptamana. Cum am vazut in sectiunile anterioare, puteti modifica datele de
disponibilitate a resurselor, precum si timpii de lucru. De exemplu, ati putea rezerva o
perioada de timp din lucrul cu o resursa pentru o vacanta sau o delegatie, facand resursa
indisponibila in tot acest timp.

,/ Note Intregul proiect are un calendar standard si, de asemenea, fiecare resursa

are propriul ei calendar standard.
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4.1. Modificarea timpilor de lucru pentru o resursa

Sa presupunem ca o anumitd resursd nu poate fi disponibild in anumite zile, sau la
anumite ore dintr-o zi. De exemplu, presupunem ca internii lucreaza de la 1:00 pm la
6:00 pm. Pentru a modifica orele de lucru pentru o resursd vom folosi tab-ul Working
Time al ferestrei Resource Information. Acesta afiseaza, la deschidere, calendarul
individual al resursei, cu data curentd selectatd. Zona de legenda din stanga ferestrei de
dialog identifica zllele de lucru, zilele libere, orele de lucru modificate si modificarile
aduse unei zile din s@ptamana sau unei zile anume din calendarul curent. Puteti selecta
datele la care resursa sa nu fe disponibila.

/.

F frae Pentru a selecta un sir continuu de zile in cadrul calendarului in sectiunea

— Select Dates selectati mai intai prima zi din sir, apoi tineti apasatd tasta

Shift si selectati ultima zi din sir. Pentru a selecta un sir discontinuu de

zile, folositi tasta CTRL si selectati fiecare din zilele dorite. Pentru a selecta toate zilele

de un anumit tip (ex. toate duminicile) selectati litera reprezentand ziua respectiva si
Project va selecta toate acele zile din toate lunile proiectului.

Realizati modificarile necesare in cadrul cAmpurilor From si To, asa cum este prezentat
in Figura 5-8. Datele pe care le-ati selectat vor aparea subliniate in calendarul
individual deoarece reprezintd o schimbare fatd de calendarul standard. Zona de
legenda va indica cd schimbarea este datd de o modificare a orarului de lucru.

Resource Information ﬁ
General Warking Time | Costs Motes ] Custom Fiehds |
Resource Name: | Intern Base calendar: | Standard 1!

Set working time for selected datels)

Selact Datels): Set selacted date(s) to
 Uise defaul
i i Morssorkdng time
= Nondefault working bme
Eram: il
i |1:00 Pra |5:00 P
| 1On this calandar:
E!E‘Edilstuadaycf I I
: the week I I
i Edits toan I I
I I
Help Detals... | ok | cancal

Figura 5-8. Selectati datele pe care vreti sa le modificati.  Project va sublinia
modificarile aparute fatd de calendarul standard.
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Daca aduceti modificari pentru o anumita zi a saptamanii, Project va sublinia
litera reprezentand acea zi si nu datele individuale.

L Nu trebuie sa selectati optiunea Nondefault working time. Chiar daca

% fereastra continua s indice ca optiunea Use default este selectatd, Project
selecteaza In mod automat optiunea Nondefault working time.

4.2. Marcarea perioadelor de vacanta

Resursele umane au si perioade in care nu lucreaza, asa ca, pentru a evita supra-
alocarea unei persoane asignandu-i taskuri pe o perioada de vacantd a acesteia, trebuie
sa definiti zilele de vacanta in calendarul individual al resursei.

Deschideti fereastra Resource Information pentru o anumita resursa si selectati tab-ul
Working Time. Selectati datele perioadelor de vacantd si apoi selectati optiunea
Nonworking time. Alegeti orice altd data din calendar pentru a incheia procesul de
selectie, iar datele de vacanta vor fi acum subliniate in cadrul calendarului. Din nou,
partea de legenda va va indica motivul sublinierii respectivelor date.

, Fiti atenti la selectarea datelor deoarece Project modificd doar datele
e aferente lunii curente dacd nu selectati literele corespunzatoare zilelor

dorite.

5. Folosirea resurselor si a acivitatilor

O mare parte a acestui capitol a fost dedicatd definirii resurselor si ajustarii
proprietatilor acestora. Acum puteti in sfarsit sa atribuiti resursele unor task-uri. Asa
cum a mai fost precizat in acest capitol, definirea de resurse ajuta la o administrare mai
eficientd a proiectului, atat din punctul de vedere al planificarii, cat si al costului.
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5.1. Atribuirea de resurse unei activitati

Puteti asigna resurse unor task-uri din view-ul ,,Gantt Chart”. Alegeti View => Gantt
Chart sau folositi toolbar-ul View pentru a trece in view-ul Gantt Chart, apoi urmariti
pasii de mai jos:

1. Selectati task-ul pentru care doriti sa atribuiti o resursa. Puteti da click pe
bara de task-uri a tabelului Gantt, sau puteti da click pe orice coloana din
tabelul Gantt.

2. Apasati pe butonul Assign Resources sau alegeti Tools => Resources =>
Assign Resources pentru a deschide fereastra Assign Resources, asa cum
este aratat in Figura 5-9

1

(Assign Resources %]
Task: Determine budgst

4+ Resource list opbions
Resources from 051 7-2002 . mpp

s 3 =)
Resource Name |R/D Urits

v | Bob Woock i

CT S =
Dolsr P i
Elenpeck T Replace... |
etern o,
Long distance Gowe_ |
Linnber i
........................................... 1...‘... - I'_hlp [

Hold down Crl and click bo selact midbiple resources

Figura 5-9: Folositi fereastra Assign Resources pentru a atribui o resursa task-
ului identificat in partea de sus a formei

3. Selectati resursa pe care doriti sa o atribuiti din lista de resurse afisata.

Ati uitat sd definiti o resursa? Nu e nevoie sa va intoarceti in zona de
Tip - . o .. c A
adaugare a resurselor. Este suficient sa scrieti numele resursei in coloana

,Resource Name” a formei Assign Resources.

4. (Optional) Daca folositi Project Server si intentionati sa folositi wizard-ul
,Resource Substitution”, scrieti un R de la Request (cerere) in campul R/D
pentru a indica cd orice resursd care are calitatile necesare poate lucra la
acest task. Puteti de asemenea sa scrieti D de la Demand (impunere) pentru
a indica ca resursa selectata trebuie neaparat sa lucreze la task.

eyt

resurse:
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Juore

5.2.

e Pentru a stabili orice cantitate diferita de 100%, scrieti cantitatea
ca un procent, In coloana Units. (Unitatile sunt definite in Project
procentual)

e Pentru a stabili procentul de 100%, lasati coloana Units libera
(Project stabileste 100% 1n mod predefinit)

Nu este necesar sa scrieti si semnul procent (%). Microsoft Project ia in
considerare pentru coloana Units valorile introduse ca fiind procente in mod
predefinit. Totusi, nu puteti stabili un procent de utilizare al resursei mai mic
de 1%.

6. Apasati pe Assign. Microsoft Project bifeazd coloana cea mai din stanga,
pentru a indica ca resursa a fost atribuita task-ului selectat.

7. Repetati pasii 3, 4 si 5 pentru a atribui resurse suplimentare pentru task-ul
selectat, sau apasati pe Close.

Selectarea mai usoara a resurselor pentru o activitate

S-ar putea sd fi observat semnul plus (+) din dreptul optiunilor pentru lista de
resurse (Resource list options), asa cum este prezentat si in partea de sus a Figurii 5-
10. Dacéd apasati butonul plus, apar o serie de optiuni menite sa va ajute in
selectarea resurselor.

(Assign Resources 8)

Task: Determing budget
_- | Resource st options
Eiker by:
¥ lﬂl Resources '_'J Mora Fikers... I

W fwailable to work |E|h _ng

Add Resources '|

Resources from 0517-2002.mpp

100%, A
Resource Name \RfD Urits
v Bob Woodk I

Deena Taneblalt |

Hold dosin Crl and click to selsct multiple resources

Figura 5-10: Puteti limita resursele care va sunt afisate prin filtrari si puteti crea noi
resurse
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Tip

Daca selectati checkbox-ul ,,Filter”, Project va prezinta o lista de modalitati in care
puteti limita lista de resurse. De exemplu, puteti cauta doar resurse materiale, sau
puteti cauta doar resurse ce apartin unui anumit grup. (Amintiti-va ca puteti grupa
resursele care au macar o caracteristicd comunad.) Daca nu gasiti un filtru care sd va
ajute, va puteti crea propriul dumneavoastrd filtru apasand ,,More Filters” si, in
fereastra care va apare pe ,,New” (consultati capitolul 7 pentru informatii referitoare
la crearea filtrelor personalizate).

Daca selectati checkbox-ul ,,Available to work”, puteti specifica numarul de ore
pentru care aveti nevoie de o resursd. Project calculeazd orele rdmase disponibile
pentru fiecare resursa pe durata task-ului selectat si compara rezultatele acestor
calcule cu numarul de ore dat de dumneavoastra. Resursele care au un numar de ore
disponibile mai mare sau egal cu aceasta valoare vor aparea in listd, alaturi de
resursele care au fost deja atribuite task-ului curent.

Project calculeazd valoarea pentru timpul disponibil de lucru folosind calendarul
resursei, conturul de disponibilitate si durata task-ului. Bazandu-se pe calendarul
resursei, Project calculeaza numarul de ore de munca pentru task-ul selectat. Pentru ca
disponibilitatea resursei poate fi redusa de conturul de disponibilitate si de alte
atribuiri, Project multiplicd orele de lucru disponibile cu valoarea conturului de
disponibilitate si apoi scade orele de lucru deja atribuite, determinand orele in care
resursa mai este disponibila.

Pentru a vedea cum functioneaza acest calcul, presupuneti ca aveti un task de indeplinit
intr-un interval de 10 zile, iar calendarul impune o zi de lucru de 8 ore. Daca ziua 3
este zi de sarbatoare iar zilele 6 si 7 sunt din sfarsitul de saptamana, pentru completarea
task-ului raman efectiv 7 zile. Daca atribuiti o resursa pentru acest task 100% din timp,
acea resursd ar fi alocata pentru 56 de ore. Dar, dacd conturul de disponibilitate al
resursei este setat la 50%, disponibilitatea resursei este redusa la 28 de ore. Si, daca
resursa este deja atribuitd unui alt task pentru 25% din timp in zilele 1 si 2 (4 ore),
timpul disponibil de lucru al resursei este de 24 de ore.

Daca aveti nevoie de o resursa pentru 12 zile, scrieti 12d in campul de
) »Available to work™, iar Project va converti aceastd valoare in 96 de ore.

Puteti apasa butonul Add Resources pentru a afisa o lista a surselor de unde puteti
selecta o resursd: din Active Directory, din agenda dumneavoastra personald (daca
folositi un client de mail compatibil MAPI cum ar fi Microsoft Outlook sau Outlook
Express), sau din Microsoft Project Server — itemii care sunt disponibili in lista
depind de mediul dumneavoastra de lucru.

20



Active Directory, una dintre optiunile care apar cand apasati ,,Add

*—’Nute Resources”, este o functionalitate de retea a Windows-ului. Intr-o retea

= Windows, administratorul poate seta un mediu Active Directory care
contine o lista de persoane impreuna cu informatiile lor de contact.

Fereastra ,,Assign Resources” contine de asemenea un buton ,,Graphs” care afiseaza
unul din cele 3 grafice pe care le puteti folosi pentru a face selectia resursei potrivite
cat mai usoara. Fiti atenti, pentru ca nici unul dintre aceste grafice nu este relationat
cu un task anume pentru care considerati atribuirea; in loc, ele sunt orientate pe

resursa.

\,Num Desi puteti selecta mai multe resurse pentru a le afisa pe grafic, aceasta
— actiune s-ar putea sd nu fie foarte folositoare cand Incercati sd atribuiti o
anumitd resursd task-ului curent.

Graficul de munca (Work graph), afisat in Figura 5-11, afiseaza munca (indiferent
de task) care este atribuita resursei selectate, in fiecare zi.

'Graphs (%]
select raph;  [Work E & J@‘
I™ Include proposed bockings whan detarmining availabity ard totdl assigned wark
I Puesources:
AN O, 03 S 065, 103
ol S [MW T T T W T JFI]s s [M]T S
15 [
£
£ 1
o
= S— _]
0_
Total!
EBob Woock
£ | »
Help Close

Figura 5-11: In acest grafic, se poate observa munca atribuitd unei resurse
selectate.

Graficul de munca per itemi de lucru, afisat in Figura 5-12, defalcheaza totalul
muncii pentru resursa considerata, afisdnd munca depusa pentru task-ul selectat,
pentru celelalte task-uri, precum si disponibilitatea totald a resursei bazatd pe
calendar. Folosirea acestui grafic va ajutd sa observati daca supra-alocati resursa
prin atribuirea ei task-ului curent.
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Graphe 0)
select raph:  [Rssgnient ek B & a
I™ Ircude propossd bockings when detarmining availibiity and totsl assgned work
I Puesources
[don 1, 03 Jun 05, '03
s (W [ T [ w [T J]F s | s [ m]T b o
£
= 15
w
&
=
=
s 0
£
£
? s Legend:
] W Selected Tass
< [H dther Tacks
9 — tyalability
Selected Tasks
Othet Tasks
Avaishiity
[ (I [>]
Help ! Clase:

Figura 5-12: Folositi acest grafic pentru a evita supra-alocarea unei resurse.

Graficul pentru disponibilitatea ramasa, afisat in Figura 5-13, afiseaza timpul in
care resursa este libera.

Daca ati supra-alocat o resursd, nu veti observa disponibilitate
Note negativa. Aceasta va aparea ca fiind 0.

‘Graphs B)
Select graph: I.net’ﬂ'mnra_ﬂnlnf :j gl ﬂ‘
I™ Include proposed bockings whan detarmining availabiity and total assigned wor:
I Resources:
[en i, 03 & 35 03
Wl s [WITTW T JF]s s TM]T b B o
£
g =
=
2 [
g
<C
g A
X
E 2
i}
Bob Wocck ot fth foh  foh  fah  fch  ith  ish  lsh ]
I i_-!_: [
_tep | [

Figura 5-13: Folositi acest grafic pentru a verifica disponibilitatea unei resurse.
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5.3.

Puteti vedea acest grafic si din ,,Resource Center” in ,,Project Web Access”

Cateva sfaturi legate de atribuirea resurselor

Puteti folosi urmatoarele sfaturi atunci cand alocati resursele:

. Puteti aloca mai multe resurse diferite aceluiasi task prin simpla
selectie a resurselor. Puteti selecta o resursa singulara si apoi sa apasati imediat
,»Assign”, sau puteti folosi tehnicile standard de selectie in Windows pentru a
selecta mai multe resurse, apasand Assign o singura data.

. Puteti atribui o resursa unui task doar o perioada de timp, dind o
valoare mai mica de 100 in coloana Units. Numarul scris de dumneavoastra
reprezintd procentajul din timpul de lucru pe care doriti ca resursa sa-l atribuie
task-ului.

o Puteti atribui mai mult de o resursa, trecind un procent mai mare
de 100 in coloana Units.

. Puteti consuma resursele materiale in dou moduri: fix si variabil.
Cand folositi consumul fix, indicati faptul ca, indiferent de cat de mult dureaza
task-ul, veti folosi aceeasi cantitate de material. De exemplu, pentru a construi o
piscind, aveti nevoie de 2 tone de beton — indiferent de cat dureaza turnatul
betonului. Cand folositi consumul variabil, indicati faptul ca durata task-ului
afecteaza cantitatea de material folosit. De exemplu, cand tundeti iarba,
cantitatea de benzind utilizatd de masina de tuns iarba depinde de timpul de
functionare al acesteia.

Puteti desemna consumul fix sau variabil in coloana Units a ferestrei Assign
Resources. Pentru a diferentia intre consumul fix si cel variabil, furnizati rata cu
care o resursd variabild este consumati. In Figura 5-14, benzina este o resursi
materiald care este consumata cu o ratd variabild deoarece in coloana Units este
inclus si timpul utilizat pentru masurarea ratei de consum — desemnat prin ,,per

2

ora .

23



& Microsoft Project - 0514 mpp

247 File Edit View Insert Format Tools Project Collaborate Window Help T¥pe & quesbon for Felp =
IR e BT W e[ E S A M 0 N [« W kit PO BN |
iv % & = T Show-|and 25 - B L UE=E = | ATk AR

Mz lavr

g x

0  Tekhame Duration | | |.Jm 07, 04 Jin 08, 1 Jun 15, 03 Jin 22, 05 =
| [FISSMTWIT[ETS[S [T WIT[F[S|STMT[w[TF[S ST W[TIFs]
1 - Build apool 11 daye | i
i = =
3 P o Assign Resources &
| Eaurthe poct 4 tays Task; Flove lawn
4 Bliid tha deck 4 days - | Resoures st options
5 Screen the pool 1 clay Eiter by:
f - Landscape 1day r| ) =]
T Feplant grazs 4 kre
= e T [ avaisbleto ek [l =
q dhes ] .F\'idRusuur\cus'_l
Rgsoices from D51+, mpo
BT S ]
Resouros Nares R/D Lnits =
[Gasoine | ]
[T r—— s
Replace,. |
s
i Hald doven ol and cick o seect multple resources i
< | J5 1 I | o
Ready haJr

Figura 5-14: Indicati consumul variabil prin specificarea unei rate atunci cand dati

cantitatea pe care o veti folosi.

Dupa ce veti atribui o resursa unui task, numele resursei va aparea in mod predefinit
langa bara task-ului in tabelul Gantt. In functie de tipul setat pentru task, puteti

folosi atribuirea de resurse pentru a modifica lungimea individualda a task-ului,

precum si programarea intregului proiect. De exemplu, dacd atribuiti resurse

suplimentare unui task orientat pe efort, cu unitati care au un consum fix, Project
scurteaza durata task-ului. Cantitatea de munca necesara nu se schimba, dar efortul
suplimentar §i concomitent scurteaza timpul in care task-ul poate fi terminat. Daca

atribuiti o resursd sa lucreze doar o parte din norma la un task orientat efort, veti
constata ca puteti termina un numar de task-uri n acelasi timp.

Daca supra-alocati o resursa prin atribuirea pentru un task a unui procent
mai mare din resursd decat este disponibil, Project va afisa resursa cu
rosu in view-ul Resource Sheet.

Tip
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5.4.

Stergerea sau modificarea atribuirii resurselor

Pentru a sterge o atribuire a unei resurse, selectati task-ul de la care doriti sa stergeti
atribuirea, in view-ul Gantt Chart. Apoi apasati pe ,,Assign Resources” sau alegeti
Tools =>Resources=>Assign Resources pentru afisarea ferestrei ,,Assign
Resources”. Selectati resursa pe care doriti pentru care doriti sa stergeti asocierea,
apoi apasati butonul ,,Remove” (vezi Figura 5-15)

(Assign Resources %

Task: Keynoke speaker

- | Resource kst opbions -
Fiker by:
= *
[T Avaisble to wark I f j

Add Resources «

Resources from 0517-2002.mpp

S 2 [z ]
Resource Name |RfC  Urits

¥ Bob Wocek
v Deena Tanenblatt

elorn 1 how [
E" 7 : 2 T e ] Yy Replace...

| Hold dowin Clrl and click to select midtiple resources

Figura 5-15: Stergerea asocierii resursei cu task-ul, prin apasarea butonului
,,Remove”

Puteti fi sigur cd la un anumit punct al proiectului dumneavoastra, veti dori sa
modificati atribuirea resurselor. Urmati urmatorii pasi pentru a comuta de la o
resursd la alta pentru un task particular:

Selectati task-ul pentru care doriti sa faceti aceastd operatie

Deschideti fereastra Assign Resources

Selectati resursa pentru care doriti stergerea asocierii cu taskul

Apasati butonul Replace. Project va deschide fereastra Replace
Resource, care va permite selectia usoara a unor resurse de inlocuire, aga cum
este prezentat n
Figura 5-16.

bl o
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Figura 5-16: Fereastra Replace Resource, asemanatoare cu A551gn Resources

5. Selectati fiecare resursd pe care doriti sd o asociati task-ului, si
furnizati si datele pentru coloana Units.
6. Apasati OK.

6. Gestiunea situatiilor atunci cand apar costuri
neobignuite

Resursele merg mana in mana cu task-urile daca incercati sa va dati seama cat timp va
trece pand la finalizarea proiectului. Dacd asignati costuri resurselor, acestea vor afecta si
costul proiectului. Cu toate acestea, asignarea unui cost unei resurse, nu este singurul mod de a
aloca un cost unui proiect. De exemplu, proiectele pot avea asociate costuri fixe. Aceastd
sectiune Tncepe cu o scurta detaliere privind costurile de proiect global si apoi se concentreaza
pe gestionare situatiilor cu cost neobisnuite.
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6.1. Privire de ansamblu asupra costului proiectului

Ati vazut cum se asigneazd costuri resurselor. cum se atribuie

De asemenea si

alocat un cost influneteaza costul proiectului. Va intrebati care e costul? De la vizualizarea
Gantt Chart fie de la vizualizarea Resource Sheet, alege Project=> Project Information pentru a

deschide caseta de dialog Project Information. Selectati Statistics pentru a deschide caseta de
dialog Project Statictics, asa cum se arata in Figura 5.17.

(Project Statistics for 1517 2002.mpp’ %)
Skart Finishy
Currant Mion D602 /03 Mo 0&f 1603
i s m R e
Actual LR D S S
‘ariance od 0d
Curation I Wiark Cost
Current 11d ; 560 $1,587.50
Baseline |
Achual
Remaining
Percent complete:
Durakion: 0% Work: 0%

Figura 5.17: Verificarea costului proiectului in caseta de dialog Project

Statistics.

Partea a IV-a acopera urmarirea pe pasi, inregistrarea muncii realizate, analizarea si raportarea
cu privire la progres. Capitolul 14 explica moduri suplimentare de a vedea costurile proiectului.
Urmatoarele sectiuni iau in considerare metode de a aloca costuri neobisnuite pentru un
proiect.

6.2. Alocarea costurilor fixe

Acest capitol s-a concentrat asupra resurselor, in care ati invatat cum sa alocati costurile
resurselor. Dar sunt costuri ce trebuie calculate diferit. In proiect, se poate aloca un cost fix
unei sarcini sau se poate aloca un cost fix unei resurse pentru o sarcina.
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6.3. Alocarea unui cost fix unei activitati

Unele task-uri au cost fix, ceea ce inseamna ca pentru un task costul ramane acelasi indiferent
de durata acestuia sau de munca depusa de orice. De exemplu, serviciul de catering, ca parte
integranta 1n fiecare loc de munca, pentru spalarea asternuturilor. Ai masina de spalat, si 1si
faci niste calcule cu privire la cantitatea de apa si de energie electrica utilizata (plus uzura)
pentru fiecare ciclu de spalare. O alta variantd, inchiriezi un loc pentru o intalnire in schimbul
unei taxe pe apartament. In toate aceste cazuri se asigneaza costul direct task-ului. Daci
asignati un cost unui task, se va adauga costul fix pentru task la costul oricarei resurse ce o
asignati task-ului cand se calculeaza costul pentru intregul proiect.

Observatie :

Asignarea unui cost fix unui task nu are neaparat ca rezultat ca, costul total al task-ului
sa fie egal cu costul fix asignat. Se poate asigna de exemplu mail mult de un cost fix ca si
costul variabil pentru un task.

Pentru a aloca un cost fix la o activitate, utilizeaza vizualizarea Gantt Chart si aplicd Cost
Table. Urmeaza acesti pasi:

1. Utilizeaza meniul View pentru a schimba vizualizarea Gantt Chart.

2. Alegeti View = Table: Entry=> Cost pentru a comuta la Cost table al vizualizarii

Gantt Chart, asa cum se arata in Figura 5.18.
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Figura 5.18: Utilizarea Cost table al vizualizarii Gantt Chart pentru asignarea de costuri
task-urilor.

3. Selectati task-ul caruia doriti sa 1i asociati un cost fix.

4. Tastati costul pentru acest task in coloana Fixed Cost column, si apdsati Enter.

Exista posibilitatea de a controla modul in care creste costul fix pentru un task din coloana
Fixed Cost Accrual. Optiunile sunt Start, Prorated, si End. Aceste alegeri au acelasi inteles ca
optiunile de crestere pentru resurse, care au fost discutate in sectiunea "Crearea unei liste de
resurse", putin mai sus in acest capitol.

Pentru a controla modul in care cresc toate costurile fixe, se va utiliza tab-ul

Calculation din caseta de dialog Options (meniu Tools => Options).
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6.4. Alocarea un cost fix de resurse pentru o activitate

Sa presupunem cd angajati un consultant pentru un task contra unei sume fixe de bani;
puteti asigna consultantul task-ului ca o resursa cu cost fix. Pentru aceasta urmati acesti pasi
pentru a asigna un cost fix unei resurse pentru un anumit task:

Nota : Meniul Help sugereaza o metodd alternativa de a aloca un cost fix per resurse
unui task; se prefera metoda descrisd mai jos, pentru ca metoda din Help poate avea unele
efecte secundare nedorite: cand se asigneaza doar o resursa unui task, task-ul devine Milestone;

la care a fost alocat costul fix pentru task.

1. Deschideti Resource Sheet. In cazul in resursa are un fel cost "pe unitate" (pe ord, pe
zi), alocati rata in campul Std. Rate. Altfel, alocati o cota standard de 0 dolari asa cum
se observa in Figura 5.19. Cresteti cota costului fix in cdmpul Cost/Use.

2. Din meniul View comutati pe vizualizarea Gantt Chart.

3. Alegeti View => Table => Costs pentru a comuta la Cost table din vizualizarea Gantt

Chart.

! Comutarea la acest tabel va da posibilitatea de a vedea impactul asupra costurilor unui task
atunci cand alocati resurse.

4. Selectati un task din coloana Task Name.

5. Alocati resurse pentru un task utilizand pasii prezentati in sectiunea "Alocarea de
resurse task-urilor", putin mai sus 1n acest capitol. Nu va faceti griji despre numarul de
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unitdti alocate; costul este "per utilizare", astfel se va aloca valoarea asignata in campul
Cost / Use la Pasul 1, indiferent de numarul de unitati atribuite.
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(4] File Edit View Insert Format Tools Project Collaborate Window Help Type & question for help. = @ X
RN R U W A WL W A e 8
P o e Show. [
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Figura 5.19: Stabilirea unei resurse cu cost fix.

Proiectul adauga costul fix al unei resurse la alte costuri resurse la calcularea costului total
pentru un task, dar costul nu depinde de timpul petrecut de o resursa pentru acel task.
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6.5. Totalul costuluiin functie de rata fiecarei resurse

In unele situatii, trebuie percepute tarife diferite pe taskuri diferite pentru aceeasi
resursa. Sau, s-ar putea este posibil ca rata resursei sa se schimbe pe parcursul proiectului.
Proiectul utilizeaza tabele rata-cost pentru a reflecta cu acuratete costurile resurselor schimbate
pe parcurs. In tabelele rati-cost puteti identifica pana la 125 rate pentru o singura resursa, si
data intrarii in vigoare a fiecarei rate. Tabelele ratd-cost va ajuta sd tineti evidenta pentru
cresteri sau scaderi de preturi la resurse pe parcursul proiectului §i vd permit sd Incdrcati
aceleasi resurse cu rate diferite, in functie de task.

Pentru a aloca mai multe rate unei resurse, utilizati tab-ul Costs din caseta de dialog Resource
Information (Figura 5.20). In fereastra Resourse Sheet, faceti dublu-click pe resursa pentru
care doriti sa se atribuie rate multiple.

rF[esuun:a Information %]

Genaral | Wiarking Time Costs Metes Custom Fields |

Resource Mame: | Bob Woack

Cost rate bables

For rakes, enker 2 valus or a percentage increase o decrease from the previous rate. For
Inskarce, IF & resource's Per Lise Cost k= reduced by 20%, vpe -20%,

A (Default) B ' e ' D ' E
$35.00/h _ _ ~
| Effective Dake [ Standard Rate Owertime Rate Per Use Cost [
o e AR §35.00/h $000 ]

Cost accrual; |F‘rurah=-.d A
Help Detais... | ok | cancel |

Figura 5.20: Utilizarea tabelelor Cost-Rate pentru a atribui rate diferite unei resurse.
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Tab-ul Costs afiseaza cinci tabele rata-cost (de la A la E) care se pot utiliza pentru a atribui
diferite rate unei resurse pentru a fi utilizate la date diferite pe parcursul unui proiect. Pentru
ficare tabel rata-cost puteti introduce pana la 25 de tarife pentru resursa selectatd si puteti
indica efectiv o datd pentru fiecare ratd. Proiectul utilizeaza datele efective pe care le-ati
furnizat pentru a aplica corect rata unei resurse la momente diferite pe parcusrul proiectului.

Nota! Daca specificati un noud ratd ca o scadere sau ca o majorare a unei rate existente, aveti
posibilitatea de a specifica noua ratd ca un procent (de exemplu +10% sau -10%); Proiectul
calculeaza  valoarea tarifului automat. Trebuie totusi introdus semnul ,,%”.

Dacd taxati sume diferite pentru resurse 1n functie de tipul de muncd pe care
acestea le exercitd, este posibil sa doriti sa folositi fiecare tab cu tabelul Cost-Rate pentru a
reprezenta seturi de tarife pentru diferite tipuri de munca.

Pentru a aloca resurse wunui task in tabelul Cost-Rate, urmati acesti pasi:

1. Asignati resursa taskului utilizand caseta de dialog Assign Resources, cum a fost
discutat in sectiunea "Alocarea de resurse taskurilor", mai devreme in acest capitol.

2. Alegeti View = Task Usage sau utilizati View bar pentru a comuta la Task Usage

(Figura 5.21).

3. In coloana Task Name, selectati resursa pentru care doriti si selectati un
tabel de costuri.

4. Faceti click pe butonul Assignement Information in toolbar-ul Standard pentru a
afisa caseta de dialog Assignement Information. Faceti click pe tab-ul General
(prezentat in Figura 5-22, pentru a selecta un tabel Cost-Rate).
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Figura 5.21: Task Usage pentru a vedea timpul in care este o resursa este atribuita
unui anumit task.
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Figura 5.22: Utilizati tab-ul Genera dinl caseta de dialog Assignement Information
pentru a selecta un tabel Cost-Rate.

5. Selectati corect tabelul cost-rate din lista derulantd cu tabele cost-rate.
6. Faceti click pe OK.

Concluzii

Acest capitol a oferit detalii despre utilizarea resurselor in proiect, inclusiv cum sa creati si sa
alocati resurse. Urmatoarele subiecte au fost acoperite:

4 Crearea unei liste de resurse

4+ Modificarea informatiilor pentru resurse, incluzdnd calendare pentru utilizarea

resurselor

4 Alocarea de resurse task-urilor si stergerea asignarilor unei resurse
4 Gestiunea costurilor fixe, atat pentru task-uri individuale cat si pentru resurse
4 Asignarea unui cost fix sau variabil unei resurse materiale

4 Setarea de rate diferite pentru resurse pentru a tine cont cresteri sau scaderi de plati

sau de taxare a resurselor la diferite rate la diferite task-uri.
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Aplicatie

Tntr-un laborator se realizeaza 10 experimente stiintifice, urmate de valorificarea rezultatelor.
Sunt folosite urmatoarele resurse umane, care se pot introduce in fereastra Resource Sheet:

e 3 cercetitori: C1, C2, C3 (salariu 65 lei/ora, Standard rate)
e 4laboranti: L1, L2, L3, L4 (salariu 40 lei/ora, Standard rate)

Pe langa resursele umane, se folosesc si resurse materiale. Cheltuielile pentru substantele necesare
experimentelor dintr-o zi sunt de 50 de lei. Cheltuielile pentru birotica si alte materiale sunt de 300
de lei, o singura data. Pentru resursele materiale, costurile sunt de tip Cost/use.

Planificarea proiectului presupune urmatoarele activitati:

e Intalnirea initiala de planificare a proiectului — 4 ore, tot personalul
e Faza de documentare
o Cautarea pe Internet a bibliografiei — 1 zi, 1 cercetator
o Cautarea la biblioteca a bibliografiei — 1 zi, in paralel cu cautarea pe Internet,
1 cercetator
o Citirea, trierea si clasificarea materialului bibliografic — 3 zile, toti cercetatorii
e Faza de exprimentare: in fiecare zi de luni pana joi, 10 zile, dupa documentare
o Pregatirea aparaturii necesare — 1 ora, 1 laborant
Pregatirea substantelor necesare — 1 ora, 1 laborant
Realizarea experimentului — 4 ore, 1 cercetator si 2 laboranti
Tntalnire in fiecare zi pentru analiza rezultatelor din ziua respectiva si planificarea
pentru ziua urmatoare — 2 ore, 2 cercetatori: cel care a coordonat experimentul din
ziua respectiva si cel care va coordona experimentul de a doua zi
e Intalnire la finalul primei siptamani pentru analiza rezultatelor — 4 ore, tot personalul
e Intalnire finald pentru analiza rezultatelor — 4 ore, toti cercetatorii
e Valorificarea rezultatelor prin realizarea unui articol legat de experiment
o Realizarea graficelor necesare si interpretarea acestora — 1 zi, 1 cercetator
o Scrierea articolului — 4 zile, poate ncepe in paralel cu realizarea graficelor,
2 cercetatori.

o O O

Daca nu se specifica altfel, dependentele sunt de tip Finish-to-Start. Activitatile sunt de tip Fixed
Duration.

La acest proiect, un laborant poate lucra cel mult 14 ore pe saptamana iar un cercetator cel mult
20 de ore. Nimeni nu poate lucra mai mult de 8 ore pe zi. Intilnirile se considera ore lucrate.
Satisfacerea constrangerilor privind numarul maxim de ore lucrate pe zi, respectiv pe saptamana, se
poate verifica n fereastra Resource Usage.

Sa se realizeze un plan de lucru cu duratele si dependentele specificate care sa foloseasca in mod
optim resursele disponibile.





